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File Menu Commands

In the File menu you can open directories to select the icons existing there, print selected icons, create a 
new icon library or exit IcoShow.

Open
Print Icons
Create Library
Refresh Directory
Exit IcoShow



Icons Menu Commands

Use this menu to determine the function of the left mouse button and to select the icons to be used.

Copy
Move
Rename
Edit
Select
Exclude



Options Menu Commands

Set options for IcoShow.

Edit with...
Repair Icons
Save Settings
Quick Delete
Quick Search



Window Menu Commands

Use this menu to arrange and size windows within IcoShow.

Cascade
Tile
Minimize Windows
Maximize Windows
Select Window
Close All
Arrange Icons



Help Menu Commands

Look here for informations about registration, ordering and the present use of heap and resources.

Registration
Print Order Form
Set Register Information
About IcoShow



Properties Menu

If you click on an icon with the right mouse button, IcoShow displays the Properties Menu. In this menu 
you can select another image if the icon has more than one. You can select the procedures available for 
this icon, such as exclude, delete, edit or rename. Only the possible properties will be displayed. In 
example the method "rename" is not available if you click on an icon from a library.
Last but not least you can change the options to determine the function of the left mouse button.

Exclude Icon
Delete Icon
Rename Icon
Edit Icon
Copy
Move
Rename
Edit



Open

Add a new window (or new windows) with the icons existing in a given directory. A dialog box will open to 
allow you to browse for the directory wanted and to check whether subdirectories and/or icon libraries (...)
are to be included and whether IcoShow is to look for and display icon names found in some libraries.

Hint: If the directory does not exist, IcoShow will create it.

See also: File Menu
Open Dialog Box



Print Icons

This command prints the selected icons in the current window on selected paper with any matrix, ink-jet 
or laser printer. You may also print in color if your printer can handle the output. The number of printed 
icons per sheet depends on the printer's resolution.

See also:    File Menu



Create Library

Transfers the selected icons from either the current window or all windows into a library. Supported library
types are    DLL/NIL/ICL.

You can put more than 2,700 icons into such a library. But if you intent to use the library later with 
Window's program manager or with some other icon manager you should not include more than 1,200 
icons. IcoShow will issue a warning.

See also: File Menu
Create Library Dialog Box



Refresh Directory

Choose this option if you wish to read icons and libraries from current directory again. Use this if you have
changed the content of the directory with a file manager while IcoShow is running.

See also: File Menu



Exit IcoShow

Use Hotkeys Alt-F4 to exit IcoShow directly.

If the option Save Settings (Options Menu) has been selected, IcoShow saves all settings including 
desktop in ICOSHOW.INI within the directory of IcoShow.Exe.

See also:    File Menu



Copy

You can drag specific icons or icons symbolizing a minimized window containing icons to a destination 
window using the mouse. Place cursor on icon, press down the left mouse button, then drag the icon to its
destination and release the mouse button.

If this option is checked, the icon(s) will be copied, not moved.

See also: Icons Menu
Properties Menu
Move



Move

You can drag specific icons or icons symbolizing a minimized window containing icons to a destination 
window using the mouse. Place cursor on icon, press down the left mouse button, then drag the icon to its
destination and release the mouse button.

If this option is checked, the icon(s) will be moved, not copied. This means that the icon files in the source
window will be deleted after copying. Icons from libraries (Exe/Dll/Nil/Icl) will not be deleted, but copied.
If the source window is empty after moving icons, you will be prompted for deletion of the directory.

Hint : Icons with identical names in the source and destination directories will not be deleted 
because they will not be moved.

See also: Icons Menu
Properties Menu
Copy



Rename

If this option is checked, you can rename icons by a double clicking them with the mouse or by pushing 
the Return key. Icons cannot be renamed and moved at the same time.

If you wish to sort the icons in the current window after the renaming is done, check the sort button.

You cannot rename icons in libraries.

See also: Icons Menu
Properties Menu
Edit



Edit

If this option is checked, a double click with the mouse or the Return key will run the command under Edit 
with...  for the icon selected. If the editor chosen is capable of command line processing, the icon will be 
opened and displayed for further processing. If    not, you will still have to open the icon you wish to alter.

See also: Icons Menu
Properties Menu
Rename



Select

If you check this command, a dialog box will be presented for you to enter a Pattern to select icons from 
the contents of the Current Window to be displayed exclusively (and for all other windows also).

See also: Icons Menu
Exclude



Exclude

If you check this command, a dialog box will be presented for you to enter a Pattern to exclude icons from
the displayed contents of the Current Window (and for all other windows also).

See also: Icons Menu
Select



Edit with ...

Here you can enter a command line to process a chosen icon. Type the complete command line to start 
the icon editor of your choice without the icon's name. That will be added when you double click the 
mouse or press the Return key and if the Edit option in Icons menu is checked.
If the editor chosen is capable of command line processing, the icon will be opened and presented for 
editing automatically. If not, only the program will be started and you will have to manually open the icon 
to be edited. Further procedure depends upon the editor itself. Do not forget to save the changes made!

If the    icon has been changed by the selected program, it will be reloaded and redisplayed on exit.

Hint : Do not use programs changing file structures on disks.

See also:    Options Menu



Repair Icons

Older icon files may contain bugs (the icon's upper border is truncated). You can have repaired these icon
files by checking this option. Bugs in libraries will not be removed.

See also:    Options Menu



Save Settings

If you check this option, IcoShow saves the current settings of all options and the desktop on exit in the 
file ICOSHOW.INI in the IcoShow directory. If missing it, will be created by IcoShow automatically.

Use Alt-Shift-F4 to save all settings including desktop while IcoShow is running (in this case the option 
"Save Settings" should not be checked).

Hint : A change of this option will always be saved to the INI file on exit.

See also: Options Menu



Quick Delete

You normally delete icons with the Del key. After pressing this key you will be prompted if you really wish 
to delete the icon.

If you want to delete icons fast however, check this option. You can then delete icons simply by dragging 
them out of the screen. You will not be prompted, the icon or all icons selected in the current window will 
be deleted!

See also: Options Menu



Quick Search

You can find an icon by using the scroll bar or by cursor keys. If you want to find an icon quickly by name, 
check this option. You may then simply type a name to find matching icons. IcoShow will locate these and
display successively. If no icons matches, the search string will be deleted automatically. Otherwise you 
will have to delete it yourself.

You can use the following characters:

Letters/digits/./_ normal characters
? stands for any single character
* stands for any number of characters
Space deletes the string
Backspace deletes the last character in the string

You can see the current entered string in the Status Line.

See also: Options Menu



Cascade

If you activate this option, all opened windows within IcoShow will be shown as a Cascade.

Hotkey:    Shift-F5

See also: Window Menu
Tile



Tile

If you activate this option, all opened windows within IcoShow will be tiled. You can see all windows 
displayed now.

Hotkey:    Shift-F4

See also: Window Menu
Cascade



Minimize Windows

If you choose this command, all windows within IcoShow will be minimized and arranged in alphabetic 
order at the bottom of the IcoShow desktop. If you have created many windows, use this command and 
the command Maximize Windows to rearrange all windows.

If this option is activated, new directories, respectively windows, will be shown minimized.

See also: Window Menu



Maximize Windows

If you choose this command, all minimized windows will be shown in default size and arranged in 
alphabetic order according to the tile or cascade option.

See also: Window Menu
Minimize Windows
Cascade
Tile



Select Window

The following dialog box will help you to select a window quickly or to calculate the number of icons which
you wish to write to a library.

See also: Window Menu
Create Library Dialog Box



Close All

Use this command to close all open windows at once. Upon closing IcoShow tries to release a maximum 
of heap space and resources.

See also:    Window Menu



Arrange Icons

Choose this command to arrange all minimized windows at the bottom of the IcoShow desktop according 
to Windows' settings. The windows will not be sorted by name.

See also:    Window Menu



Registration

The author's hints for registering and how to contact him.

See also: Help Menu
Print Order Form



Print Order Form

If you wish to order a license for IcoShow, you can fill in the form online and print it from here. Switch on 
your printer!

After printing the form is not saved to disk. After you pressed the OK button you will have to fill it in anew 
to print another copy.

See also: Help Menu
Registration
About IcoShow



Set Register Information

After you have registered your copy, you receive a password. In the following dialog box you must enter 
your full name (like "Gustav Hackendahl") and the received password. If the password contains spaces, 
you must enter the spaces too.
After you have filled in your name and the password, IcoShow writes the information to the INI file 
("Registered=" and "Password="). It does not check the entered information now!

See also: Help Menu
Registration
About IcoShow



About IcoShow

Use this to display information on copyright and the present use of heap and resources.

See also:    Help Menu



Exclude Icon

Choose this option if you wish to exclude the current icon from further processing. You can select this icon
again if you change the criteria for selecting and/or excluding icons (Select/Exclude within Icons Menu) or 
if you choose the menu point Refresh Directory from File Menu!

See also:    Properties Menu



Delete Icon

Choose this option if you wish to delete icons from disk too. You cannot delete icons from libraries. These 
will be deleted from display only.

See also:    Menu Properties



Rename Icon

If you choose this option, you will be prompted for a new name of the icon. You cannot rename icons from
libraries directly, however.

Check the    "Sort" box if you wish to sort the display in the current window after renaming. The icon will be
displayed then at its proper place within the window according to its new name.

See also:    Menu Properties



Edit Icon

If you choose this option, IcoShow will run the program from Edit with.

See also:    Menu Properties



Open Dialog Box

Add a new window (or new windows) with the icons existing in a given directory. A dialog box will open to 
allow you to browse for the directory wanted and to check whether subdirectories and/or icon libraries (...)
are to be included and whether IcoShow is to look for and display icon names found in some libraries.

Hint: If the directory does not exist, IcoShow will create it.

Drives and Directories
Subdirectories
Libraries
Search for Names



Drives and Directories

Browse for the name of a drive and/or directory or enter it in the list box below. If you click the OK button 
or press the Return key, processing of the directory starts.

See also:    Open Dialog Box



Subdirectories

Select this option if you wish to look for icons in subdirectories of the main directory or drive chosen, too. 
Each directory containing icons will be shown as    a separate window.

See also:    Open Dialog Box



Libraries

Check this box if you want to search for icons included in library files too. You may check all types of 
libraries supported (Exe/Dll/Nil/Icl) or select specific ones.

See also:    Open Dialog Box



Search for Names

Many icon libraries include names for the icons. If you wish to display those names along with the icons, 
check this box.

If this option has not been checked or if there are no names assigned to the icons, the library's name is 
used, suffixed by a running number.

See also: Open Dialog Box



Print Icons Dialog Box

This dialog box will open after you have issued the Print Icons command in the File Menu.
By checking the print names box you will have the names assigned to the icons printed along with the 
design itself.

See also: Print Names with Icons



Print Names with Icons

If you check this button, the names of the icons will be printed below the images.

See also: Print Icons



Create Library Dialog Box

In this dialog box you can set the options to create a library. If the library already exists, you will be 
prompted to delete it before you go on.

IcoShow can put over 2,700 icons in a single icon library. But if you want to use the library later with the 
program manager you should not include more than 1,200 icons. IcoShow will issue a warning.

Only the icons selected will be written to the library. Please check Select/Exclude in Icons Menu to see if 
your choice corresponds with your intentions.

If you overwrite an old library, you need disk space for both the old and the new version.

Library Name
Type of the Library
Current Window Only
Selected Windows Only
All Windows
Sort Icons
Write Names with Icons
Exclude Duplicates
Write all Images



Library Name

Enter the name of the library in this field or select it from the list box below.

Default name for the library is ICONS.DLL. IcoShow writes the last name used to the INI file if you have 
selected "Save Settings" in the option menu.

See also:    Create Library Dialog Box



Type of the Library

Choose the type of library you wish to create here. Supported are DLL, NIL and ICL files.

See also:    Create Library Dialog Box



Current Window Only

Check this box if you wish to write only the icons selected in the current window.

See also: Create Library Dialog Box
Selected Windows Only
All Windows



Selected Windows Only

Check this box if you wish to write only the icons in the windows selected. You can select these windows 
in the Select Window Dialog Box from Window Menu.

See also: Create Library Dialog Box
Current Window Only
All Windows



All Windows

Check this box if you wish to write the icons selected in all windows.

See also: Create Library Dialog Box
Current Window Only
Selected Windows Only



Sort Icons

Check this box to write all icons selected in alphabetic order. If this box is not checked, the icons will be 
written successively.

Hint: IcoShow sorts the pathnames of the windows in alphabetic order, ascend if windows are 
minimized and descend if windows are maximized or normally shown (see also menu 
Minimize Windows and Maximize Windows under Window Menu).

See also:    Create Library Dialog Box



Write Names with Icons

Check this box to write icons to the library including their names. If icons have no names, IcoShow builds 
names using up to 5 characters from the library's name and a 3 character index including only letters and 
digits (46656 variants).

See also:    Create Library Dialog Box



Exclude Duplicates

Check this box to instruct IcoShow to compare all icons and to exclude duplicates from all the icons to be 
written to the library.

You can use this possibility to eliminate duplicate icons from your directory even if you want them 
as .ICO-files.    Write all icons to a library while this box is checked, delete icon files and extract them from
the library again.

See also:    Create Library Dialog Box



Write all Images

Some icons include more than one image for displays with different numbers of colors. Normally the 
image selected for your display will be written to the library. If this box is checked, IcoShow will write all 
images to the library. That will minimize the number of stored icons!

See also:    Create Library Dialog Box



Select Icons Dialog Box

In this dialog box you can enter the Pattern used to select icons for processing.

See also:    Exclude Icons Dialog Box



Pattern to Select/Exclude

The following characters may be used in the pattern string:

Letter/digit/./_ normal characters, upper and lower case are not distinguished
? any character
* a number of any characters
[] a class of characters
^ negates the class of characters in []
- a range of characters in    []

Examples for pattern:

A* all icons, starting with the letter A    as ALPHA.ICO
A same

A[ABCDE] all icons starting with the letter A followed by one of the letters A, B, C, D or E
A[A-E] same
A[^F-Z] also the same if only letters possible

Please watch out for interactions between Select and Exclude.



Exclude Icons Dialog Box

In this dialog box you can enter the Pattern used to exclude icons from processing.

See also:    Select Icons Dialog Box



Edit with... Dialog Box

In this dialog box you can enter the command line used to start icon processing, usually the complet path 
to start the icon editor of your choice. The name of the icon to be edited will be added when the command
is issued, so the editor will open with the icon already displayed. This will work only if the editor is capable
of command line processing.

See also:    Edit with...



Rename Icon Dialog Box

In this dialog box you can enter a new name for the selected icon. You cannot rename icons from libraries
directly, however.

Check the    "Sort" box if you wish to sort the display in the current window after renaming. The icon will be
displayed then at its proper place within the window according to its new name.



Select Window Dialog Box

This dialog box will help you to select a window quickly or to calculate the number of icons which you wish
to write to a library.

Use the Shift key to select more than one window.

If only one window is highlighted, this window will be activated after you press the Enter key or click the 
OK button.
If more than one window is selected, you can write all icons from windows selected to one library 
together.

See also:    Create Library Dialog Box



Registration Dialog Box

You will get familiar with this dialog box if you have not registered by December 31st, 1992.



Print Order Form Dialog Box

In this dialog box you may fill in the text for the order form. Printing starts after the print button was 
clicked.

After printing the form is not saved to disk. After you pressed the OK button you will have to fill it in anew 
to print another copy.



About IcoShow Dialog Box

Here are copyright messages and some informations on heap and resources used.

"Free Heap" shows you the minimum of local and global heap. That will be sure the minimum
of the local heap.

"Free Resources" shows you the minimum of the local heap from User and GDI.

"Processed Icons" shows you the amount of icons read overall.

Check these informations. If you see that "Free Heap" is very small, close windows to free local heap. An 
overflow in local heap stops IcoShow immediately.
If there are no more windows or dialog boxes displayed, you have too many opened windows.

Critical for allocation is not the number of processed icons, these can be over 10,000, but rather the 
number of open windows.



Status Line

The status line offers the following informations:

- state of command Copy/Move in Icons Menu
- state of command Rename/Edit in Icons Menu

- amount of icons readed and selected and number of open windows

- amount of icons in the current window or a (sub-)string if Quick Search has been activated.



Install Icons to Program-Manager

You can install icons directly in the program manager if you reduce the size of the IcoShow window until 
you see the destination.

Place cursor on icon, press down the left mouse button, then drag the icon to its destination and release 
the mouse button.




